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After completing this module, you 

will be able to:

 Navigate the Analysis Area Workspace

 Define, Modify and Delete an Analysis Area

 Understand the Advanced Functions and best practices of the 

Analysis Area tool

Duration: 2 hours



Ad hoc Reporting Overview

Lesson 01

4



What is an Ad hoc Report? 

• A report built from an “ANALYSIS AREA” or pre-defined 
aggregated transactional data table for on-demand reporting.

• After build, users can:
1. Save as an analysis workspace to My Documents
2. Export as analysis view (data source) for WebI

Tool Name:

Analysis Edition for OLAP
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Ad hoc Reporting Overview

Only BI Power Users & Analytical Users

Who can create ad hoc reports? Typical use?

To produce on-demand reports and/or 
detailed analysis for Senior Management, 
auditors, & functional supervisors 



Into the Analysis Edition for OLAPFrom the Documents Tab

Overview for Creating an Ad hoc Report
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NAVIGATE TO A FUNCTIONAL 

AREA FOLDER / OPEN 

ANALYSIS AREA

COMPLETE PROMPTS 

TO RUN REPORT 

(always save prompts)

REVIEW METADATA 

EXPLORER FOR 

AVAILABLE OBJECTS

1 2 3

Working in the Analysis Edition for OLAP (Cont.)

DRAG & DROP 

OBJECTS INTO 

LAYOUT PANEL

FILTER 

CHARACTERISTICS/

KEY FIGURES

ANALYZE DATA

& FORMAT REPORT

5 6 74

PROCESS STEPS 

FOR CREATING AN 

AD HOC REPORT 

FROM AN 

ANALYSIS AREA

SAVE ANALYSIS AREA 

TO MY FAVORITES



Analysis Area Breakdown

To access an Analysis Area, navigate from the Documents tab to launch a 
new window for further customization.
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Analysis Area Window

Tool 
Panel

Layout 
Panel

SCREEN BREAKDOWN

1

3

4

Metadata 
Explorer2



Frequently Used Icons

Note frequently used icons when modifying & defining analysis areas:
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Name Icon Description Examples

Key Figures Numerical values that are used in the analysis Value and Volume

Single Figure
By default, all Key Figures are displayed in the 

analysis area. Single Figures/metrics can be 

displayed instead

Value 

Characteristics
Fields that are used to differentiate and analyze 

Key Figures

Fund and Purchasing

Organizations

Attribute Used to describe Characteristics in more detail
Address is an attribute of 

Vendor

Filter
Method to focus the analysis on a specific

characteristic or key figure
Filter Fund by UNIFIL



Analysis Area Basic Actions

Lesson 02
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 DEFINE & SAVE A NEW ANALYSIS AREA 

 MODIFY AN ANALYSIS AREA

Basic Actions Overview

Throughout this lesson your instructor will perform live 
demonstration of each action.  Please follow along.
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ANALYSIS AREA BASIC ACTIONS 



Define a New Analysis Area
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Define a New Analysis Area
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To “define” a new analysis area or “create an ad hoc report”:

1. Select a Functional Area folder under Umoja BI

2. Double click desired Analysis Workspace

Analysis Workspace 

is the same as 

analysis area

1

2

CONTINUED

FACT

Note: All Functional Areas have their own pre-defined Analysis Workspaces

Analysis areas 
CANNOT be 
created from 
scratch – they 
always derives 
from a pre-
existing 
analysis area.



Define New (Cont.)
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A prompts window will launch to require further defining:

1. Complete *required prompts and/or select the Display Member Selector icon to 
specify from Member Selection window

2. Check the box to “Save prompt values with workspace” as a best practice

3. Select Ok

Display 
Member 
Selector1

2
3

FACT

Users MUST 
select “Save 
Prompt 
values” when 
exporting as 
analysis view 
(data source) 
to WebI.

Member Selection Window



Save an Analysis Area 
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To save the new defined analysis area/ad hoc report:

1. Click the Save icon (floppy disk) & select “Save As…”

2. After the Save window appears, navigate to your “My Documents” folder

3. Change “File Name” to something unique related to the analysis area

4. Click “Save”

FACT

Users 
CANNOT 
overwrite 
existing 
analysis 
areas.

1

3

2

4



Export an Analysis View
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STEP 1

Navigate to the 
desired Analysis Area

STEP 2

Save as workspace to 
Favorites folder & modify 
accordingly (must Save 
prompt values)

STEP 3

Export the analysis 
workspace as an Analysis 
View to My Favorites folder

Note: Analysis Views must be added to the Shared Analysis folder when used as data 
sources for WebI Reports that will be shared and opened by other users.



Modify an Analysis Area
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Breakdown: Tool Panel

17Note: The Tool Panel can be hidden to maximize Analysis window space

Connect to 

a Data 

Source

Refresh 

Prompts 

Values

Hide 

Data 

Panel

User access data sources, properties, & display changes.

Disconnect 

to a Data 

Source

DATA ICON
Opens the Data tab to add/remove data sources 

Performs navigation functions (e.g. add hierarchy 
to rows or columns, add a background filter)

PROPERTIES ICON
Opens the Properties tab to display properties of 

a selected component of the report (i.e. column 
width, field name change)

OUTLINE ICON
Opens the Outline tab to provide an overview of 

the current workspace (e.g. the # of sheets)



Breakdown: Metadata Explorer
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Metadata 

Explorer

Contains all Key Figures & 
Characteristics of the analysis area

To display all associated data fields 
for a given area, drag the Key 
Figures into the Layout Panel

Additional customization available 
by dragging single characteristics 
into the Layout Panel

To display the Metadata Explorer Panel, select the Data tab.

KEY FIGURES:
List of numerical 
measures, e.g. 

counts & amounts

CHARACTERISTIC: 
descriptive attribute of  

key figures

Good to know:
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Breakdown: Layout Panel

A dynamic, customization tool for user report build.

Rows & Columns in analysis areas allow users to 
build a report similar to a pivot table in excel

Users can view data hierarchies & measures

Users can add/remove Single Figures/  
Characteristics/Attributes  from the Layout Panel

Background filters can be applied to filter by 
member that is not currently displayed directly in 
the data (e.g. budget period affecting the whole 
report)

Click to hide 

the Layout 

PanelDiscard 

Changes

Note: The Layout Panel can be hidden to maximize window space

Good to know:

Apply 

Background 

Filter to filter 

member

Undo



Modify an Analysis Area
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Start on the Data panel & activate “Auto Update” to avoid system load 

delays (right-side pane           ). Then complete the following:

1. Clear all applied Key Figures/Characteristics 
by dragging out of the Layout panel into 
the Metadata Explorer Area

2. Drag & drop chosen Single 
Figures/Characteristics/Attributes
into the Layout Panel

Drag & Drop to clear the 

Analysis Workspace

Drag & 

Drop new 

to modify

1
2

Note: The Key Figures Icon changes to the Filter icon when Single Figures are applied

CONTINUED

DRAG & DROP



Breakdown: Analysis Area Window
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Best practice: KEY FIGURES in “COLUMNS” & CHARACTERISTICS in “ROWS” –
use according to preference  or select “Swap Axes” from the Display tab

ColumnsRows

Active user view of the report as it is being built.

Sometimes users cannot see Key 
Figures, expand window as needed

Create a copy sheet to avoid 
overwriting work

Conditional formatting & 
calculations are examples of 
advanced functions that can be 
applied from the Analyze tab

Good to know:

Sheets

Analyze tab



Filters 

To apply new filters to Key Figures or Characteristics:

1. Right click on the Key Figure or Characteristic, select Filter, then By member
2. Click on Select Everything box to clear current selection & select applicable field boxes
3. Click OK to update the report
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1

2

3

Key Figures 

fields

Right click Key Figure to 

launch Filter Menu

Click box to 

clear selection 

FILTER

Note: The Filter window can also be accessed by double-clicking on a Key Figure
or Characteristic.



Display As 

Display As provides users the flexibility to display characteristics according to 

Key, Text, and more detailed Descriptions. Apply the following to change 
displays:

1. Right click on a characteristic of choice, select the Display As menu
2. The Display as menu will allow users to choose from a selection of descriptions 
3. Upon selecting a description, contents of the chosen characteristic will auto-update
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DISPLAY AS

Key : Text

1 2 3

Note: Display as can also be applied to characteristics as users are filtering. 



Copy / Paste Sheets 
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Copy and Pasting sheets is useful for users who are interested in continuing 
analysis, but want to keep work open.  Apply the following:

1. Select the Analysis Area to be copied 
2. Select the Copy icon 
3. Navigate to Sheet 2 (rename sheet accordingly) 
4. Select the Paste icon

12
4

COPY/PASTE

3



Totals 
Totals are most frequently used in analysis areas for aggregating data on 
multiple levels. Apply totals by the following method: 

1. Right click on a column of choice, select the Totals menu and choose Show totals 
2. On the Display tab, select the Totals icon to Position totals before/after members 
3. An Overall Result/sub-total will appear on the Key Figures (top right of analysis)

25
Note: To apply an Overall Result, show totals on the FIRST column. To apply sub-totals, 
show totals on the column to the RIGHT of the desired sub-totaled characteristic.

TOTALS

1

2

3



Delete an Analysis Area
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To delete an analysis area or sub-analysis: 

1. Select a desired Analysis from the Data panel

2. Select the Delete Icon

Delete icon

Select desired 

deleted analysis 

or sub-analysis

1

2

DELETE



Learning Checkpoint
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Please answer the following questions

1. The Metadata Explorer window can be found in the:

a) Layout Panel

b) Data Panel

c) Properties Tab

d) Analysis Workspace

2. True or False: Key Figures can only display in columns of the Analysis Area

3. True or False:  All BI Users may access Analysis Areas.



Learning Checkpoint Answers
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Please answer the following questions

1. The Metadata Explorer window can be found in the:

a) Layout Panel

b) Data Panel

c) Properties Tab

d) Analysis Workspace

2. True or False:  Key Figures can only display in columns of the Analysis Area

False: It is a best practice, but Key Figures can be displayed in both rows and columns.

3. True or False:  All BI Users may access Analysis Areas.

False: Only Analytical and Power Users may access Analysis Areas.



Practice Exercise: Let’s Try It
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P
R

A
C

T
IC

E

DURATION: 20 MIN

REPORT

 Grants Management 

 GM/FM Budget Analysis Area

PROMPTS

 As Of Date: August 11, 2015

 Fund Hierarchy: All Fund Groups

TASKS

 Drag and drop so that Grant and Funds 
Center are the only Characteristics in Rows 

 Filter Grant to only display GMNR : NOT 
RELEVANT GRANT

 Scroll to the bottom to see all values

 Clear all Key Figures

 Add in Pre-Commitments, Commitments 
and Total Committed into the Key Figures

 Display text only

Tip: Disable the AutoUpdate feature while dragging characteristics, and enable to refresh the Analysis Area

To engage hand-on experience within the BI Portal, users are encouraged to try it 
themselves.  Let’s take the time to complete the exercise for Define a New Analysis Area. 
Area.



Navigating Functional Tools

Lesson 03

30



Analyze Tab Overview

 FILTER

 SORT
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ANALYZE TAB

TOPICS 

Throughout this lesson your instructor will perform live 
demonstration of each action.  Please follow along.

 CALCULATIONS (Custom & Dynamic)

 CONDITIONAL FORMATTING  



Analyze Tab

32



Filter

1. Right click on either a Key Figure or Characteristic from the column title
2. Select Filter button from the Analyze tab
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Data can be filtered by either MEASURE or MEMBER

Good to know:

Column Title

1

Filter 

button

2



Filter by Measure
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Filter by Measure is available to Characteristics only, allowing users 

to filter according to Key Figure values.

Characteristic: 

G/L Account

Chosen 

Key 

Figure

Continued 

filter rule 

defined



Filter by Member
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Filtering by Member differs 

significantly between Key 

Figures and Characteristics.

When applied to a Characteristic, it filters by available values

When applied to Key Figures, it only allows list selection of Key Figures to be 
included in the analysis

Expectations for  filters:



Sort 
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SORT

Data can be sorted by Ascending/Descending order.

1. Right click on the desired Key Figure
2. Display the Sort menu 

3. Select to sort data by Ascending/Descending order
4. The chosen Key Figure will sort accordingly

1

2 3

4Sort toolbar icon

Note: Both the toolbar icon and right-click menu can be used to apply sorting



Calculations

Calculations allow users to further analyze Key Figures by 
applying custom or dynamic formulas to the data.
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ICON

KEY 

FEATURES

 Calculations based on multiple Key Figures 

 Customize formulas or use  pre-defined 
formulas 

 Ex: % of Key Figure A over B

 Calculation based on single Key Figure
 Ex: Moving Averages,  Accumulative 

Sum, Percentage of Overall Result / 
Parent 

Custom Calculation Dynamic Calculation 

Calculation window for customization Pre-defined drop-down menu

There are 2 types of Calculations, as noted below:

MENU

CONTINUED



Custom Calculation
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To create a Custom Calculation apply the following steps:

1. Click on the Calculations button & Select 
Custom Calculation

2. A Calculation window will appear to specify 
desired Functions (use Percent A for a 

traditional percent rather than a deviation)

3. Replace operands with Key Figures by 
selecting Add Member 

4. Name the custom calculation
5. A new Key Figure will be added to your report 

as per the custom calculation created

CUSTOM CALCULATION

5

3

4
2

1

Custom Calculation 
toolbar icon

Description of 
calculation 

Note: The toolbar icon & right-click menu can be used to apply a custom calculation 

Validate formula



Dynamic Calculation 
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To create a Dynamic Calculation apply the following steps:

1. Right click on the desired Key Figure
2. Display the Dynamic Calculation menu 

3. Select the desired function
4. A new Key Figure will be added to your 

report based on the dynamic calculation

DYNAMIC CALCULATION

1

2
3

4

Dynamic Calculation 
toolbar icon

Note: The toolbar icon & right-click menu can be used to apply a custom calculation 



Conditional Formatting 
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CONDITIONAL FORMATTING

Conditional formatting is used to highlight Key Figure values that meet 

or exceed a certain threshold by applying the following:

1. Click on the Conditional Formatting icon
2. A window will appear where format settings/ 

rules can be defined based on Key Figures

3. Select the Add button to create the defined 
formatting rule then select OK 

4. Specified formatting will apply to the 
selected Key Figure 

Ex: % Budget 
Consumed 

Greater than 
75%d

1 2

3

4

Conditional 
Formatting 
toolbar icon

Note: Both the toolbar icon and right-click menu can be used to apply 

conditional formatting



Insert Tab

41



Insert Tab Overview

 CREATE A SUB-ANALYSIS AREA 

 ADD A CHART

 CHART WITH FOCUSED ANALYSIS
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INSERT TAB

TOPICS 

Throughout this lesson your instructor will perform live 
demonstration of each action.  Please follow along.



Create a Sub-Analysis Area

Sub-Analysis Areas are used to section off a sub-set of data from an existing 
Analysis Workspace by completing the following steps:

1. Select the Display tab
2. Highlight desired Columns and Rows for the sub-analysis area
3. Select Focused Analysis

43

Be sure to select 

desired Columns/Rows1

2

3

Note: Columns & Rows must be adjacent (i.e. next to each other) to 
populate the sub-analysis area

SUB-ANALYSIS AREA

CONTINUED



Sub-Analysis (Cont.)
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4. Click the Insert tab 

5. Select the Insert a Crosstab icon and 

click Insert a Sub-Analysis from the 

drop-down menu
2

5

6

4

Crosstab icon

6. The new Sub-Analysis will 

appear in the Analysis 

Workspace

New

Sub-Analysis 

Note: Only the highlighted columns appear in the Sub-Analysis



45

Add a Chart

Charts are added to workspaces to present data graphically & illustrate 

trends within reports. Chart types noted below:

 Clustered bar and column charts
 Stacked bar and column charts
 100% stacked bar and column charts
 3D column charts
 Multi-line charts
 Pie charts
 Scatter charts
 Box plot charts
 Bubble charts
 Radar charts

Note: Most frequently used charts within BI

CHART TYPES

CONTINUED



Add a Chart

To add a chart to a report complete the following:

1. Select the Insert tab
2. Select the Chart icon from the toolbar (as noted below)
3. The chart will appear in a new Sub-Analysis

46

Clustered 
Column Chart

Line Chart Pie 
Chart

Clustered 
Bar Chart

New Chart 
appears

Note: For further chart customization, select the Properties icon

1
2

3

ADD A CHART

Good to Know: Unless 
highlighting specific 
columns/rows, multiple 
charts will appear.



Chart with Focused Analysis

1. Highlight the desired 
Characteristic/Key Figure 

2. Select Focused Analysis on 
the Display Tab

3. Select a Chart type on the 
Insert Tab (i.e. Clustered Bar)

4. The focused chart will appear 
in a new  Sub-Analysis 
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To create a focused analysis chart with a specific sub-set of data, complete the 

following:

1
2

3

4

FOCUSED CHART



Learning Checkpoint
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Please answer the following questions

1. In order to Add a Chart users must select:

a) Metadata Explorer

b) Insert Tab

c) Analyze Tab

d) Background Panel 

2. True or False: A Sub-Analysis Area can be renamed in the Data tab?  
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Learning Checkpoint Answers

Please answer the following questions

1. In order to Add a Chart users must select:

a) Metadata Explorer

b) Insert Tab

c) Analyze Tab

d) Background Panel 

2. True or False: A Sub-Analysis Area can be renamed in the Properties tab?  

True



Practice Exercise: Let’s Try It
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P
R

A
C

T
IC

E

DURATION: 10 MIN

REPORT

 Source to Acquire

 Requisitions Analysis Area

PROMPTS

 Fund : UNIFIL 

TASKS

 Remove All Key Figures

 Add “Shopping Carts” as the only Key 
Figure

 Insert a Pie Chart

 Re-format sub-analysis area to display 
chart to the right of the analysis area

 Go to Properties tab and re-name 
Chart to “Shopping Carts by Purchasing 
Group”

 Adjust chart properties as needed 

 Change your chart type 

Tip: Disable the AutoUpdate feature while dragging characteristics, and enable to refresh the Analysis Area

To engage hand-on experience within the BI Portal, users are encouraged to try it 
themselves.  Let’s take the time to complete the exercise for Add a Chart.



Display Tab



Display Tab Overview

 SWAP AXES

 HIERARCHY 

 MEASURE FORMAT

 NULLS & ZEROS 

52

DISPLAY TAB

TOPICS 



Swap Axes 
The Swap Axes function allows users to swap contents from Columns & 

Rows fields in the Layout Panel with a single click of a button:

1. Click on the Swap Axes icon on the Display Tab

2. The contents of the Layout Panel swap and the data in the analysis workspace reloads

53

2

1

SWAP AXES



Hierarchy 

Hierarchy is used to display row/column Characteristics in a hierarchical 

tree rather than side-by-side. To display a hierarchy: 

1. Click on the Hierarchy button in the Display tab
2. Select a Compact Display in Rows or Columns 
3. Characteristics are organized in an expandable tree hierarchy 

54

1

2

3

Expand/Collapse 

Hierarchy

HIERARCHY

Note: Users are able to “Expand to” and “Show” different levels of the hierarchy by 
right-clicking on the hierarchy characteristic  



Measure Format 

Users can specify the format of each Measure (i.e. Key Figure) by applying the 
following:

1. Click on the Measure Format button in the Display tab and Prompt window will appear 
2. Select the Measures to be formatted 
3. Specify the Measure Type (i.e. Server, Number, Percentage, Scientific)
4. Specify Options (i.e. Decimal Places, Thousands separator, Negative numbers, etc)
5. Preview your Measures and click OK to apply all format changes 

55

1

2 3 4

5

MEASURE FORMAT



Nulls & Zeros 

Users can hide all nulls and zeros from displaying in the report by 

applying the following:

1. Notice that several rows in the report have nulls & zeros that should be hidden 
2. Click on the Nulls & Zeros drop-down list in the Display tab, and select Hide in row 
3. The Analysis Area will update with hidden rows as specified (no impact to report)
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NULLS & ZEROS

1

2

3



Training Material Reference Sheet

Listed below is related training material for the Introduction to Ad hoc Reporting module:
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Video Demos

• Open an Existing 
Workspace 

• Define a New Analysis Area

• Add a Chart

Practice Exercises
• Define a New Analysis Area
• Add a Chart 

https://www.unumoja.net/share/s/bivEZZTMRWKq3A90gu9tOw
https://www.unumoja.net/share/s/Ju7tQ6OcSW6q40npKoQEgg
https://www.unumoja.net/share/s/43y_p95oTFW3cAKTNh8_yQ


Thank You


